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3.2 Learning Materials from the Implementation Proj ects 
 
 
This section of the toolkit contains a selection of the learning materials developed to 
support students and staff taking part in the implementation activities.  The following 
documents are provided: 
 

·  Education Blogging Project: Workshop for Students (pages 52-56) 
 

·  Psychology Wiki Project: Detailed Notes for Students (pages 57-66) 
 

·  Psychology Wiki Project: Brief Notes for Students (pages 67-69) 
 

·  Psychology Wiki Project: Notes for Demonstrators (pages 70-72) 
 

·  Chemistry Photo Sharing Project: Instructions for Students (pages 73-80) 
 

·  Biology Photo Sharing Project: Instructions for Students (pages 81-83) 
 

·  Medicine Podcasting Project: Technical Help for Students (pages 84-89) 
 

·  Arts Social Bookmarking Project: Workshop for Students (pages 90-95) 
 

·  Arts Social Bookmarking Project: DIY Guide for Students (pages 96-104) 
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Education Blogging Project: Workshop for Students 
 

EEA310 Blog Workshop 
 

What is a blog? 

Wikipedia, the online collaborative encylopedia provides the following definition of the term 
‘blog’: 

A blog (an abridgment of the term web log) is a website, usually maintained by an 
individual, with regular entries of commentary, descriptions of events, or other material 
such as graphics or video. Entries are commonly displayed in reverse chronological order. 
"Blog" can also be used as a verb, meaning to maintain or add content to a blog. Many 
blogs provide commentary or news on a particular subject; others function as more 
personal online diaries. A typical blog combines text, images, and links to other blogs, web 
pages, and other media related to its topic. The ability for readers to leave comments in an 
interactive format is an important part of many blogs.  

The use of blogs in the EEA310 fits with this definition in some ways and doesn't in others. 
Certainly the blogs will contain a "description of events", "maintained by an individual", and 
will allow "readers to leave comments". However, although it is possible to include graphics, 
the inclusion of video material is not really feasible. The nature of the task probably lends 
itself more towards text only blogs, although the inclusion of photographic material in initial 
introductory posts in order to personalise the blog is certainly to be encouraged. 

Access the blog tool 

The Blog tool to be used in EEA310 is called Blog Wow and is part of Interact. To 
access the Blog tool, login to Interact and then choose the ‘Blog’ link in the left hand 
menu. 

 
Read a blog 

Blogs are organised under the name of the ‘blogger’ (the blog author). When you first 
access the blog tool you will see a list of the names of everybody who has read or 
posted a blog. You can return to this list at any time by clicking on ‘All the blogs’ or 

on the  icon. The number of blog postings by this person is listed next to their 
name. 

Exercise: Click on the name of somebody who has posted at least one blog. 

All of the blogs by this person are then displayed in reverse chronological order. 
 
View comments 

Underneath each blog is a list of buttons. The ‘n comments’ button takes you to the 
comments that have been posted on this blog if there are any. 
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Exercise: Find a blog with at least one comment and view the comments posted. 
 
Post a comment 

The ‘Leave a comment’ button under a blog brings up a box into which you can type a 
comment. You can either go ahead and publish your comment or cancel. 

Exercise: Post a comment on a blog. 

Notice that after you publish your comment you remain on the screen that allows you 
to post comments until you return to ‘All the blogs’. 

 
Before you post your first Blog 

Before posting your first Blog you should edit your Blog profile by choosing the ‘my 
blog settings’ option and change the ‘Maximum number of entries to show on my 
blog (empty for unlimited)’ to 100. This will ensure that other students can see all of 
your Blog postings, rather than just your most recent 10. 

 
Post an initial Blog 

To post a blog click on the ‘Add blog entry’ option. (If you can’t see this option click 
on  

‘All the blogs’ or on the  option. 

A text area with a set of editing and formatting tools is displayed.  

You must type in a title for your blog or the ‘Publish entry’ option won’t work. 

Exercise: Create a blog posting. For now, just use plain text or basic formatting. 

Give your blog an informative title, such as “A first experimental blog” or 
“Classroom management plan”. It is important that other students can differentiate 
between your experimental blogs and the blogs you have created as part of the 
assignment. You will be able to delete your blog if you wish (see below). 

Before choosing ‘Publish entry’ make sure you choose the ‘All members of this 
site can see this entry’ option. Although blog entries are never public because access 
to the tool requires an Interact username and password, it is important that blog 
postings are restricted to students and staff involved in the subject. 

Exercise: After posting your blog go and view some other students’ blogs and post 
some comments on them. 

 
Edit a Blog 

You can edit a blog by clicking on the ‘Edit entry’ button underneath it. 
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Exercise: Edit the blog posting you created above. 

As a rule it is preferable that you don’t edit your blog postings once others have 
commented on them. This is important because other students will need to include the 
blogs they have commented on as appendices in their assignment. 

 
Formatting text 

The formatting options in the blog editor include basic character formatting such as 
font, font size, bold, italics and underlining as well as paragraph formatting such as 
indentation, bullets, numbered lists and paragraph alignment. 

Exercise: Create another blog posting and experiment with the formatting option. 

As explained below there are some formatting tools that should in general be avoided 
because they don’t work as expected in all cases. These include the Style and 
Template options. 

 
Pasting text 

You can paste plain text using Ctrl-V or by right-clicking and choosing Paste just as 
you would in any other application. 

However, if you want to paste formatted text from Word you should use the following 

button: . This button provides a window in which to place the text and then 
converts the formatting before placing it into the editing window. 

Exercise: Experiment with pasting unformatted and formatted text from Word. 

 
Adding a picture 

In order to include a picture in a blog posting you need to first upload the image file 
into the resources tool. This can be done from within the blog editor so you don’t need 
to go out of the blog tool to do so. 

The first step is to click on the insert image button:  in the blog editor. From here 
you can do one of the following: 

·  Specify the web address (URL) of an image that exists on another web site; or 

·  Use the ‘browse server’ option to select an image that has previously been 
uploaded into the resources area of this or another Interact site; 

·  Use the ‘browse server’ option, followed by the ‘Browse’ and the ‘Upload’ buttons 
to first upload an image from your local computer or USB drive into the resources 
area and to then choose this image within the ‘browse server’ dialog box. 

Exercise: Save an image from a web page to your desktop or USB drive, then upload 
it and add it to a blog posting. 
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Note that only images in a web compatible format (eg. JPEG, GIF or PNG) can be 
included in a blog. If you have an image in another format that you’d like to use 
you’ll need to first convert it in an image editing program. 

 
Delete a blog posting 

You can delete your own blog posting but not those posted by other people. The 
button under each blog posting labelled ‘Remove entry’. 

Exercise: Remove one of your experimental blog postings. 

As a rule it is preferable that you don’t delete your blog postings once others have 
commented on them. As mentioned previously this is important because other 
students will need to include the blogs they have commented on as appendices in their 
assignment. 

 
Modify your profile 

When viewing the blog posting of a particular ‘blogger’, the person’s profile 
information is displayed in the right hand column. You can enter textual information 
and upload a picture that will be displayed as part of your profile. This gives you the 
opportunity to add character to your blogs. 

To enter or modify your blog profile, choose the ‘My blog settings’ option. 

Exercise: Enter some text into your blog profile. 

To enter a picture into your blog profile you can either specify the web address (URL) 
of a picture that is already on the web, or you can first upload an image into the 
resources area and then copy and paste the link into the URL field in the profile 
editor. 

Exercise: Add a picture either of yourself or of something that you think characterises 
you into your blog profile, by first saving the image file to your desktop or thumb 
drive, then uploading it into the ‘Images for Blogs’ folder in the resources area, and 
then copying and pasting the link into your profile. 

 
Printing blogs and comments 

You will need to print your own blog postings and the comments you have posted on 
other people’s blogs, along with these blogs themselves, and include them as 
appendices in your assignment.  

If you just display a person’s blog postings and then choose print not all blog postings 
are printed. A better approach is to select the postings you want to print with the 
mouse, choose File-Print and then in the print dialog box specify ‘Selection’.   

Exercise: Print one of your blog postings along with all comments posted by other 
students. 
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Unexpected behaviours to be aware of 

After posting a comment, the name of Blogger link leads to a page with broken 
links 

After posting a comment you can get back to a list of the Blogs using the “All the 
Blogs” option. If you accidentally click on the Blogger name you can get back to the 

list of Blogs by clicking on the  icon. 

The Permissions link brings up an empty screen 

The Permissions option will generally bring up an empty screen. You can return to the 

list of Blogs by clicking on the   icon. 

Recovering from the unexpected 

The icon that looks like the following  will return to the list of Blogs if the other 
links stop working at any stage. 

 
Other things to avoid 

Comment moderation 

You should not choose the setting within “My Blog settings” labelled “I want to 
authorize any comments on my blog”. It is important that students are able to freely 
comment on each others Blogs. 

Use of styles when formatting text 

The styles options in the editor will change the appearance of the text while editing 
but the text will revert to unformatted once the Blog is saved. 

Use of templates when formatting text 

Some of the templates provided in the editor (accessible from the  icon) don’t 
work as expected and so it is safest to not use this option. 
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Psychology Wiki Project: Detailed Notes for Student s 
 
 

Psychology 
Mind, Brain and Behaviour Wiki  

 
Two Activities in Semester 1, 2008 

 
Notes for Students 

 
 
 
Activity 1: Commentary + Comments 
 
As part of your Psychology course in first Semester we will be using an online tool 
called a wiki. A wiki is a website that allows group or collective authoring. The most 
famous wiki is Wikipedia, the online encyclopedia that has over two million English 
pages authored collectively by about 75,000 people.  
 
The first way in which we will use the wiki is for Commentary and Comments.  
 
We will start by posting additional ideas and perspectives on the concepts that you are 
encountering in lectures, a bit like an extension to the subjects and comments already 
appearing on the discussion board. This commentary will provide an alternative 
overview of the course and will hopefully provoke you to think about what you are 
learning from the lectures. One goal of this is to start you thinking how the lecture 
series fits in with psychology as a whole and, by extension, for you to start to perhaps 
revise or solidify your ideas about what Psychology as an academic discipline is. I 
have already suggested a starting point to you, the internal versus the external worlds, 
and I will return to this idea in the Sensation and Perception lecture series but there 
are two important overarching questions for you to consider here: 

·  What is the nature of an individual’s (i.e. your) internal representation of the 
world and what is its relationship to the external environment? 

·  How does this contribute to or inform our broader understanding of what 
Psychology is and how the academic and the practical aspects of Psychology 
interrelate? 

 
The first commentary will be posted sometime in Week 3 and the there will be regular 
postings after this time.  
 
Your role in all this is simple: just read our commentary and comment on it when you 
feel the urge, or comment on other students’ comments. We have allocated some time 
in the Practical class in Week 5 to discuss what is up on the Wiki so it would be good 
for you to at least have a look at it before then. Note that this activity is for you; the 
aim is to get you thinking and it is not part of this subject’s formal assessment. 
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Activity 2: Collaborative Writing 
 
You will also be using this wiki for a Collaborative Writing activity.  
 
In Week 6 of the Semester, I will present two lectures on Motion Detection and 
during Week 7 and 8 you will be asked to create a summary of these two lectures 
using the wiki. But rather than all students doing this on their own, one summary of 
these two lectures on Motion Detection will be prepared by each lab class as a piece 
of collaborative writing.  
 
The idea is for each lab class to write a rich Wikipedia-style entry on Motion 
Detection. As a guide, the summary should include information on the following 
concepts: 

·  Basic (simple) motion detection 
·  Integrating individual vectors into flow fields 
·  Attention and motion detection 
·  Eye movements and motion detection 
·  Biological motion detection 

 
In addition, you might also like to consider computational, behavioural and biological 
approaches to vision and how the study of motion detection relates to each of them. 
 
When you are writing your wiki summary there will be little point just copying and 
pasting information from a text book or from the Motion Detection entry on 
Wikipedia ... we will be able to tell and this is not the point of the exercise. The point 
is to create a useful, scholarly, web-based resource on Motion Detection that is full of 
your group’s descriptions, disagreements, reflections, quotes, images, web links and 
diagrams. Get creative and hopefully your summaries will be useful when you’re 
preparing for exams at the end of semester. 
 
You will be given time in your Practical Classes to work on the wiki in Week 7. Your 
tutors will ask you to form study groups in your Practical Class and each group will 
be asked to prepare written notes on topics in the area of Motion Detection. These 
notes can then form the basis for postings to the wiki.  
 
Assessment  
You will be given an assignment on the Sensation and Perception component of the 
course and 10% of your mark for this assignment (4% of your total mark) will be 
based on your contribution to this Collaborative Writing task. Your contribution will 
be deemed as satisfactory if you have made at least two contributions to the content 
on the wiki by the start of Week 9 (9.00am; Monday, May 5, 2008). While it will be 
possible to make minor alterations to the wiki to fulfill the assessment requirements, 
we would encourage you not to do this as it is not really in the spirit of the exercise.  
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How To 
 
In Week 3 you will be sent an email/announcement giving you the web address 
(URL) and the password to the site so that you can log onto the wiki and get started.  
[This information is also contained below].  
 

It is important  that you use your University email address when you first log on 
to the wiki as this is the only way we know you have made a contribution to the site.  

If you don’t do this you cannot be assessed for this activity. 

 
 
 
The remainder of this document provides you with all the essential information you 
will need to use the wiki, including:  

·  How to log onto the wiki 
·  How to view the lecturer’s commentary 
·  How to post a comment on a wiki page 
·  How to access and view your Lab Group’s Wiki 
·  How to edit you Lab Group’s Wiki 
·  Where to go for more help.  

 
Please note that if you are a Mac User the best browser to use is Firefox. If you use 
Safari then some of the editing functions of the wiki (like linking to web pages) will 
not be available. Windows users can use Internet Explorer or Firefox. 
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How to Log onto the Wiki 
 
To log on: 
 
1. Go to: http://unimelb-psych-mbb1.pbwiki.com and you should see something like 

this: 

 
 

2. On the left hand side under where it says “Log on with a Password /Invite Key”  
·  Type the word “Sensation” in the “Wiki Password/Invite Key” box  
·  Type your name in the “Name” box 
·  Type your University email address in the “Email” box 

 
3. Then click on the “Log In” button 
 
4. You will be directed to the ‘Home’ or ‘FrontPage’ for the Mind, Brain & 

Behaviour Wiki. It will look something like this: 
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How to view the lecturer’s commentary 
 

1. From the ‘FrontPage’ of the Mind, Brain and Behaviour Wiki there is a 
section called ‘Commentary and Comments’. If you click on the title or the 
‘here’ link in the paragraph text it will take you to the commentary page. 
Alternatively you can just use the URL: https://unimelb-psych-
mbb1.pbwiki.com/Commentary 

 

 
 
 

2. This will take you to a page that has this a title like this: 
 

 
  
 During the semester this page will be built up with commentary.  
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How to post a comment on a wiki page 
 

1. Every Wiki page will have a “Comments” button in the menu at the top of the 
page.  
 

 
 
To make a comment simply click on this “Comments” button. This will take 
you to a page that has a text entry box at the bottom: the comments box.  

 

 
 
If others have already commented on the wiki page, these comments will 
appear before the comment box, so you might have to scroll down a bit to 
make your comments. All you need to do is enter your comment in the box 
and then click on the “add comment” button.  
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How to access and view your Lab Group’s Wiki 
 

1. You can access your Lab Group’s Wiki from the FrontPage of the Mind, Brain 
and Behaviour wiki: a list of all the lab classes is at the bottom of the page.  
Simply find your lab group time and click on the appropriate group link. So, 
for example, if your lab class is at Tuesday at 10 in the morning, you would 
click on the ‘Group 8’ link.  

 

 
 

2. When you click on your lab group this will take you to a new wiki page. This 
is the page (or series of pages) where you and other members of your lab class 
will construct your summary of Motion Detection. Don’t be alarmed if there is 
nothing on the page other than a heading … this just means that nobody has 
made a contribution yet. You can be the first! 
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How to contribute to and edit you Lab Group’s Wiki 
 
It is pretty easy to edit the wiki pages once you get into the swing of things. The most 
important thing to realise is that a wiki page can exist in two basic states: 'View' and 
'Edit'. 

·  When you look at the wiki in the 'View' state it's just like viewing a regular 
web page. 

·  When you look at the wiki in the 'Edit' state it is like you are working with 
something akin to a word document; you can change and edit the text and 
media on the page.  

 
 
So when you use the wiki you will be constantly moving between these two states. 
 

1. If you want to edit a page simply click on the 'Edit page' button; there is one at 
the top and at the bottom of the page. 
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This will open a new window which has as its title "Editing ..." .  
 

 
 

2. From here all you do is add content (text, images, weblinks, etc) in the same 
way as you would with a Word document. By using the toolbar at the top of 
the page you can change the style, font and colour of the text, the colour of the 
background; you can insert a table or an image from your computer or 
hyperlink to another page on the web. 

 
3. When you are finished click the 'Save' button at the bottom of the page and 

you will be taken back to the 'View' state of the page you were editing. 
 

4. If you want to make another change (which is inevitable) … simply go 
through the ‘edit-save-view’ process again.  
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General Help 
 

1. There are some really useful tips and help files at the Pbwiki site; see: 
http://newfaq.pbwiki.com/ 

 
Of particular use might be the help on  
“Editing (using the Pbwiki Point-and-Click Editor”. 

 

  
 
Heaps of questions are answered here including: 

·  What is this new Point-and-Click editor? 
·  How do I add a page?  
·  How do I delete or rename pages? 
·  How do I find earlier versions/revisions of pages? 
·  How can I change a page back to an earlier version? (revert) 
·  How do I link to a page? 
·  How can I add pictures? 
·  Why are my file uploads being blocked? 
·  Why can’t I delete files or pages? 
·  How can I make a picture smaller on my wiki page? 

 
 
If you are having a problem with PBwiki you should … 

·  Speak to your classmates or other members of you’re lab group to see if they 
can help you; 

·  Speak to your lab tutor; 
·  If you are really struggling you can get limited technical help by emailing the 

wiki’s administrator at:   tsj@unimelb.edu.au  
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Psychology Wiki Project: Brief Notes for Students 
 
 

Psych Wiki  -  Collaborative Writing Activity 

Student Notes 
 

 
What you have been asked to do 
 
Create a useful, scholarly, researched, reflective web-based resource on motion 
detection that has descriptions, examples, quotes, images, diagrams, animations, 
photos and web links.  
 
·  It will hopefully contain examples that draw on and describe your experiences in 

everyday life. 
·  It will hopefully contain examples gathered from the web (appropriately 

referenced). 
·  It will hopefully contain different perspectives (disagreements) from members of 

your group.  
·  It will hopefully contain quotes from and references to other sources (movies, 

books, music videos, museums, lecturers, popular press, current affairs  and news, 
TV shows, radio, live performances, etc, etc).  

·  It is not meant to be a carbon copy of your text book or the wikipedia entry on 
motion detection.  

 
 
What content areas should be covered (at a minimum) 
 
·  Basic (simple) motion detection 
·  Integrating individual vectors into flow fields 
·  Attention and motion detection 
·  Eye movements and motion detection 
·  Biological motion detection 
 
Also should consider computational, behavioural and biological approaches to vision 
and how motion detection relates to each of them.  
 
 
How to do it 
 
You will work in small groups in your lab classes and your demonstrator will let you 
know what he or she wants you to do in class.  
 
·  But here are some things you might want to do so to contribute to your group’s 

wiki: 
- Find web-based examples (images, diagrams, animations, photos, articles) 

that relate to a chosen topic or the task more generally.  
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- Come up with good, well known or typical examples from everyday life to 
support your group’s descriptions of concepts. Examples from around the 
University might provide a useful point of reference.  

- Use a camera to take pictures exemplifying concepts and upload them to 
the wiki.  

- Think about ‘bad’ examples as well as ‘good’ ones - these are often just as 
conceptually illuminating.  

- It will not be unusual for different people to have different perspectives on 
the topics you are covering. A clear description of differences of opinion 
and how they were resolved - if at all - could be included in the wiki. 

- Hunt out quotes from and references to other sources, from anywhere 
really: movies, books, music videos, art, popular press, current affairs and 
news, TV shows, radio, live performances etc, etc. 

- Think about how what is being written on your wiki fits with other 
concepts in the course; or how it fits other concepts covered in the 
Commentary part of the wiki. Write your thoughts down and add them to 
the wiki.  

- Think about the structure and design of your wiki site; will it be a single 
page, multiple pages? Will there be links within it, links to other stuff on 
the web? What is the architecture of the information; what is a good way 
to put it together so it makes sense to others? It is cohesive? Is it simple 
and easy to use? What about the look and feel of the thing? While not 
content, this is important to communicating the ideas that your group is 
coming up with.  

 
 
Collaborative writing and wiki etiquette 
 
Many of you may be unfamiliar with this type of collaborative writing; you’re 
probably more used to discussing concepts with others before writing up your own 
work individually.  
 
It is worth thinking about some of the challenges associated with collaborative 
writing. For example:  
·  What happens when there is a difference of opinion on what content should be 

included on the wiki page? Who wins a ‘edit war’ on a wiki? How can differences 
be resolved? 

·  A good strategy to remember here is that differences of opinion can be discussed 
using the comments section of a wiki page. This might help clarify where people 
are coming from and let the group see what’s going on.  

·  If differences of opinion cannot be resolved then there is always the option of 
putting both opinions/versions up on the wiki (either showing alternative 
perspectives on the same page or as separate pages).  

·  If you do make a change to the text or the structure of the site that you think is on 
the large side; make a comment too to let people know what you have done and 
why.  
 

It is also worth thinking about the etiquette associated with editing a wiki. What are 
rules of thumb here? Here are a few guidelines: 
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·  Any editing should be a genuine attempt to improve the value of what is up on the 
wiki page.  

·  Be sensitive to other people’s perspectives.  
·  Don’t be too precious about your own postings – be prepared to consider other 

peoples edits, comments and critiques. 
·  Remember there are many ways to express the same idea; posing a single idea in a 

variety of ways is often helpful and typically there is no one best way to express 
things.  

·  Don’t be afraid to contribute and edit other people work, but if you are unsure 
then consider flagging it first in comments.  
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Psychology Wiki Project: Notes for Demonstrators 
 

Psych Wiki  -  Collaborative Writing Activity 

Demonstrator Notes 
 

 
What students have been asked to do 
 
Create a useful, scholarly, researched, reflective web-based resource on motion 
detection that has descriptions, examples, quotes, images, diagrams, animations, 
photos and web links.  
 
·  It will hopefully contain examples that students draw on and describe from 

everyday life. 
·  It will hopefully contain examples that students gather from the web (ideally 

appropriately referenced). 
·  It will hopefully contain different perspectives (disagreements) from members of 

the group.  
·  It will hopefully contain quotes from and references to other sources (movies, 

books, music videos, museums, lecturers, popular press, current affairs  and news, 
TV shows, radio, live performances, any texts really).  

·  It is not meant to be a carbon copy of their text book nor the wikipedia entry on 
motion detection.  

 
 
What content should be covered (at a minimum) 
 
·  Basic (simple) motion detection 
·  Integrating individual vectors into flow fields 
·  Attention and motion detection 
·  Eye movements and motion detection 
·  Biological motion detection 
 
Also students have been asked to consider computational, behavioural and biological 
approaches to vision and how motion detection relates to each of them.  
 
 
Ideas for Activities in and outside the Lab Classes 
 
·  We have suggested that students will do small group work (in say, teams of 4-5) 

in this lab. 
·  Consider dividing students, or asking students to divide themselves into groups 

based on the content areas to be covered. This will avoid replication of effort 
across the class. 

·  Suggest that one person from each group takes notes. 
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·  Suggest that an easy way to start would be to brainstorm about what would be 
contained in a text based definition of the content area they are looking at. It 
would seem an easyish goal for the small groups to arrive at a working 
definition/description by the end of the lab. (This would also seem to be the 
minimum a group or an individual could do … each member of the group could 
upload a part of the definition to meet the requirements of the task … but we 
would not encourage this level of engagement with the activity). 

·  Other things that you could encourage students to do inside or outside the lab 
would be to ask them to: 

- find web based examples (images, diagrams, animations, photos, articles) 
that relate to their topic or the task more generally.  

- come up with good, well-known, or typical examples from everyday life to 
support the description of concepts. Examples from around University 
might be offered as a suggestion.  

- find ‘bad’ examples as these are often as conceptually illuminating as 
‘good’ ones.  

- explicitly consider alternative perspectives on the concepts they are writing 
about … there may even be disagreements in the group … this is not 
unusual and such  disagreements and the process of their resolution (or 
lack there of) could be included in the wiki. 

- find quotes from and references to other sources (movies, books, music 
videos, art, popular press, current affairs and news, TV shows, radio, live 
performances, any text really).  

- think and write about how ‘their’ section/piece fits with other concepts in 
the Motion Detection exercise; or how it fits with other concepts in the 
course; or how it fits other concepts covered in the Commentary part of the 
wiki.  

- think about the structure and design of their wiki site; will it be a single 
page, multiple pages? Will there be links within it, links to other stuff on 
the web? What is the architecture of the information; what is a good way 
to put it together so it makes sense to others? Is it simple and easy to use? 
What about the look and feel of the thing. While not content, this is 
important to communicating the ideas that the group is coming up with.  

 
 
Collaborative writing 
 
Many students will be unfamiliar with collaborative writing; they will be more used to 
discussing concepts with others before writing up their own work individually.  
 
·  It might be worth asking students about some of the challenges associated with 

collaborative writing: 
o Differences of opinion on what content should be included on the wiki 

page 
Who wins a ‘edit war’ on a wiki? How can differences be resolved? 

o Differences of opinion can be discussed using the comments section of a 
wiki page. 

o If the differences cannot be resolved then there is always the option of 
putting both opinions/versions up on the wiki (either showing alternative 
perspectives on the same page or as separate pages).  
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·  Etiquette associated with editing a wiki. What are rules of thumb here?  
o Any editing should be a genuine attempt to improve the value of what is 

up on the wiki page.  
o Be sensitive to other people’s perspectives.  
o Don’t be too precious about your own postings – be prepared to consider 

others edits and critiques. 
o Remember there are many ways to express the same idea; posing a single 

idea in a variety of ways is often helpful and typically there is no one best 
way to express things.  

o Don’t be afraid to contribute and edit other people work but if you are 
unsure then consider flagging it first in comments.  

o Large changes to the text or structure of the site can be accompanied by a 
comment to let people know what has been done and why.  
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Chemistry Photo Sharing Project: Instructions for S tudents 
 
 

101 ILT4 Chemistry Around Us - Digital Photo Archive 
 
Introduction 

Chemistry is often referred to as the Central Science. It provides the fundamental language 

that describes how our world "works" at the molecular level. This language is applied 

throughout biology, medicine, engineering, materials science, pharmacology, ... 

 

In this ILT you will be asked to reflect on how the chemical concepts and ideas that make up 

Chemistry 610-101 relate to the world around you. 

 

The task has the following objectives: 

·  to make connections between the chemical world that you experience and the 

chemistry topics presented and discussed in Chemistry 101, 

·  to record some of these connections using your own camera or camera-phone, and 

then upload images to a shared subject group website and add some notes, 

·  to share your observations of chemistry in the world with other students in the class 

·  to learn from other students' observations by reviewing what they have found, 

photographed and uploaded, and nominate some good examples, 

·  to broaden your general IT literacy and skills with technology, and 

·  to develop your own abilities to plan and execute a short but complex 'open ended' 

task. 

 
 
You will only be able to complete the task well if you think ahead and plan your time. 

Though it is only a few hours total work, any attempt to cram it all into the last day or so 

before the cut off date will not work. Read ahead now and plan to be 'starting' around 

midsemester. 

 

As well as these notes, a website at http://www.mdhsonline.unimelb.edu.au/chemflickr/ is 

being set up, where updates, answers to frequently asked questions, links to useful technical 

help and other information can be found. The Chemistry Digital Photo Archive is a 

collaborative project between the School of Chemistry and the Biomedical Multimedia Unit 

in MDHS. 

 

Exercise 1 (Weeks 5-7) - Join the Chemistry 101 MU_ Chem 'Flickr' group 
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Flickr is a website that allows people to share photos. In Week 5, you will receive an email 

inviting you to join the MU_ChemFlickr group. This process will require you to: 

 

1. Join Yahoo (if you don’t have an account already) 

2. Join Flickr 

3. Join the MU_Chem group within Flickr 

 

Note that if you have an existing Flickr account, you will EITHER have to change your Flickr 

username into the MU_Chem format, OR follow the instructions below to create new Yahoo 

and Flickr accounts. The choice is yours, but it may be cleaner to keep the MU_ChemFlickr 

project separate from your personal use of Flickr, and to set up a new Yahoo ID account. 

 

To do this: 

 

1. Click on the link in the MU_Chem email, then click on 'Sign In'. 

 

2a. If you ALREADY have a Yahoo ID and password, but not Flickr, enter your Yahoo login 

details. 

 

2b. If you DO NOT have a Yahoo ID and password, click on “sign up” in the bottom righthand 

corner of the dialogue box. Follow the steps to sign up to a Yahoo account. You can use 

whatever username you choose. 

 

3. When asked “Ready to experience Flickr?” click on “Continue”. Make a new Flickr account 

using the Flickr username you have been assigned in the email. It must be in the format 

MU_mystudentnumber. Once you have provided the details required, click on “Create my 

account”. 

 

4. Once the account has been created, you will have to sign in. You will automatically be a 

member of the MU_Chem group, with a link to visit the group. 

 

The task of setting up your Flickr account must be complete by the end of Week 7 (April 25). 

 

 

Exercise 2 (Weeks 5-10) - Taking and uploading your  digital photo 

images 

 

Based on your student number, you have been assigned two topics to photograph and 

another topic to later review. You are required to take at least two photos - at least one of 

each of your two 'Photo Topics' - illustrating the topics and then annotate and tag your photos 
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using Flickr as set out in Exercise 3. This task will be easier if you think about it every once in 

a while, over time. If your phone has a camera and you keep it with you most of the time, you 

may be able to catch something when you least expect it. 

 

The topics are listed below. Some of them may refer to ideas that will be developed more fully 

later in your 610-101/102 subjects, so some brief reading, using your textbooks or the web, 

may be necessary. This is background that will obviously also help you with the topic when 

you come to it later. 

 

Topic 0 : Slow oxidation 

Compulsory Tag: SlowOxidation 

Acid/base (proton transfer processes) and redox reactions (electron transfers) are the most 

fundamental of chemical processes. We will define 'slow' oxidations as those that take more 

than minutes. Your caption should include reference to the oxidant, reductant and chemical 

conditions recorded in your image. 

 

Topic 1: A collection symmetric and asymmetric objects 

Compulsory Tag: ChiralObjects 

Many manufactured and natural objects are symmetrical and others are not. Your photo must 

incorporate several 'manufactured' or 'created' objects in the same image - some of these 

must be symmetric (superimposable on their mirror image) and some chiral 

(nonsuperimposable on their mirror image). Your caption should point out which are which. 

 

Topic 2 : Conversion of energy and chemical potential energy 

Compulsory Tag: EnergyConversion 

All sources of energy on earth are fundamentally derived from the sun. Your image here must 

involve a process in which chemicals are the energy source or the result of the energy 

conversion. Your caption should be specific about the chemical species involved and the 

process of conversion that is occurring in the image. 

Topic 3 : The Second Law of Thermodynamics and free energy 

Compulsory Tag: SecondLaw 

Spontaneous processes are not simply driven by whether heat is absorbed or released. The 

fundamental driver is an increase in entropy in the Universe. There are a wide range of 

natural physical and chemical processes that could illustrate this idea. Your caption should 

refer to the entropy changes captured in your image. 

 

Topic 4: Fast oxidation 

Compulsory Tag: FastOxidation 

Acid/base (proton transfer processes) and redox reactions (electron transfers) are the most 

fundamental of chemical processes. We will define 'fast' oxidations as those that take less 
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than minutes. Your caption should include reference to the oxidant, reductant and chemical 

conditions recorded in your image. 

 

Topic 5: Travelling and Standing Waves 

Compulsory Tag: WaveProperties 

X-ray diffraction relies on measuring scattered x-rays to determine atomic positions. The 

modern model for electrons in atoms builds from their 'wave properties'. You may need to 

read a little about the nature of waves. Find some examples of travelling or standing waves. 

Your caption could also comment on the differences between these wave types. 

 

Topic 6: Control of acidity 

Compulsory Tag: ControlAcidity 

Control of pH is often critical to a reaction occurring or not. These may be biological, 

environmental or industrial processes. Your photo must be of something where pH is an 

important property or characteristic in the material or process. The caption should say why pH 

is important and give details of the reagent being used to control or set the acidity. 

 

Topic 7: Chemical Equilibrium 

Compulsory Tag: ChemicalEquilibrium 

Though the concentrations of chemical species do not change with time at 'equilibrium', at the 

molecular level, formation and breakdown is occurring continuously. You are not restricted to 

chemical processes, but the system you show must involve a fundamental balance of 

processes that results in 'dynamic equilibrium'. 

 

Topic 8: Chemical Composition 

Compulsory Tag: ChemComposition 

Chemical constituents are listed on many products. For this topic, you might photograph a 

product label, for example. Based on the data there, your caption should include the role and 

concentration - using the most chemically useful concentration scale, mol L-1 - of the major 

listed component (or components). For 'trade names', you need their chemical formulas. 

 

Topic 9: Green Washing 

Compulsory Tag: GreenWashing 

Greenwashing is an attempt by some companies to present a product as 'environmentally 

friendly' as a marketing ploy. For example, 'chemical free' is not really a sensible description. 

Your image should show the use of scientific terms as part of the marketing – to attract the 

buyer's attention - not necessarily in a scientifically useful way. 
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You have been assigned two Photo Topics, for which you must take and upload a total 

of at least two photos, and a Review Topic, for whi ch you will review the work 

submitted by others in the class. 

 

Student number  Photo Topics  Review Topic 

... ends in 0 0 and 1 5 

... ends in 1  1 and 2  6 

... ends in 2  2 and 3  7 

... ends in 3  3 and 4  8 

... ends in 4  4 and 5  9 

... ends in 5  5 and 6  0 

... ends in 6  6 and 7  1 

... ends in 7  7 and 8  2 

... ends in 8  8 and 9  3 

... ends in 9 9 and 0  4 

 

 

Your digital photos must meet the following criteria: 

 

1. Each image must be an original photo, taken by you. Photographs by others or taken from 

the web are the copyright property of another person; although they may be 

freely available, it is a common misconception that they are 'free' to do what you like with - 

they are not. Any images that you submit as part of this ILT must be your own work. 

 

2. Your image must be an illustration of the topic that has been assigned to you. In 

Exercise 3, you will describe your photograph with a caption or description. This should not 

just be a 'title', but modelled on the captions that are used to describe figures in a textbook for 

example, making a connection between the image and the important chemical principles or 

ideas the image illustrates. Think about this when you take the photo; perhaps make some 

notes at the time. 

 

An important reminder: The posting of any inappropriate images will result in your immediate 

failure of the ILT4 task and may have other consequences. More information about University 

of Melbourne policy and guidelines in these areas may be obtained at the following websites: 

 

Student expectations and responsibilities policy 

http://www.services.unimelb.edu.au/policy/expectations/expectations.html  

 

Computing and network facilities rules 

http://www.unimelb.edu.au/Statutes/r81r7.html  
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Photos can be taken with your own digital or phone camera or using equipment available for 

loan through the First Year Chemistry Laboratory. You will need to book the loan equipment 

in advance. 

 

Exercise 3 (Week 10) - Finalize the tagging and cap tions for your photos 

on Flickr 

 

This Independent Learning Task (ILT 4) requires you to load a minimum of two photos on to 

the MU_Chem Flickr website. Each photo must contain the appropriate title, tags and 

description to be eligible for assessment. 

 

Having taken your photos, upload them onto the MU_Chem Flickr group site, in two steps. 

 

1. Upload photos to your personal Flickr homepage first. 

 

(i) Log in to Flickr 

(ii) Click on "upload photos" and follow the Flickr instructions to upload your photos 

 

As you go, remember to include titles, descriptions and tags: 

 

Titles: Give your photos titles using the following compulsory format: 

MU_myStudentNumber.a, MU_myStudentNumber.b, MU_myStudentNumber.c, 

 

Description: Directly under the photo where it says “click here to add a description” include 

your caption, in 30 words or less, of how this photo describes the topic. As noted earlier, use 

the model of a figure caption in a chemistry textbook to succinctly describe the chemical ideas 

shown in the image. 

 

Tags: It is a requirement that each photo have at least two tags. One will be the compulsory 

topic tag for your Photo Topic. To do this click on “Add a tag”. 

Now, also add at least one other tag that is relevant to your topic. Each should be a single 

word, like 'environment' or 'vegetable' or 'metal', though you can use the convention of linking 

words, like 'highTemperature' or 'airPollution' or 'swimmingPool'. Ideas from others' tags are 

useful, because it allows unplanned 'clouds' of overlap to develop and be explored later in the 

Review task. 

 

2. Upload your photo(s) to the MU_Chem group area. 

 

(i) Open each photo. 
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(ii) Click on the 'send to group' button, above the photo. 

 

(iii) Click on the MU_Chem group. 

 

You are welcome to upload, tag and caption your photos at any time up to Week 10. Details 

on how to do this are given in Exercise 3 below. If you find a better image, then just add it 

to your contributions rather than delete the old one. Give it a new title in the sequence 

MU_myStudentNumber.a, MU_myStudentNumber.b, MU_myStudentNumber.c, ... You might 

find some of the 'optional tags' others have used are relevant to your image - add them at 

any time. You can also edit your descriptions. 

 

Note that there are various sources of technical support available. 

·  For your own equipment, there are manufacturer manuals and websites. 

·  You can go to www.flickr.com/help/ for specific Flickr help, 

·  On http://www.mdhsonline.unimelb.edu.au/chemflickr , we will post or update 

information as we get it. 

·  You can visit the tutor who will be available in the Chemistry First Year Learning 

·  Centre at times to be advertised through the chemflickr site and on the LMS. 

 

Exercise 4 (Week11) - Review and nominate images fr om your Review 

Topic 

By week 11 everyone should have completed submission of their photos to the Flickr 

MU_Chem website. You must now nominate your choices of best and second best photo in 

your assigned Review Topic, using a survey form on the LMS. The LMS Grade Book will 

show that you have done this and pass on your nominations and comments to the review 

database. 

 

Exercise 4.1 - View the photos in your Review Topic  

Log in to Flickr and go to the MU_Chem group site. 

1. Click on 'pool'. 

2. Click on 'all group tags' 

3. Select your assigned topic name. Hint: As you find photos you like if you click on "add to 

favs" (above the photo) this will give you a shortlist for later. 

4. Make some notes about the photos you will nominate in the last task at 4.2 

 

Exercise 4.2 - Nominate the two best photos in your  Review Topic 

 

1. Log into the LMS, and go to the Chemistry 610-101 site. 
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2. Click on "Tests" in the blue margin 

 

3. Click on "ILT 4 -Flickr - Photo Archive". 

You are now ready to complete the LMS record of your own contributions to Flickr and record 

your comments on others' uploaded images. 

 

4. First, input the title and tags of all of your MU_Chem photos in the form title/tag1/tag2, 

title/tag1/tag2/tag3, ... in the text field 

 

5a. Then, input the title for your first choice as best photo in your Review Topic. The title will 

be in the format MU_studentnumber.a. The following are things you might consider when 

deciding on your choices: interest, relevance, surprise, insight, creativity, 

originality, ... 

 

5b. Briefly give the reasons for your choice of this photo in the text field. 

 

6a. Input the title for your choice as second best photo in your Review Topic. 

 

6b. Briefly give the reasons for your choice of this photo in the text field. 

 

7. When you are satisfied that you have completed 4, 5 and 6, click 'Submit'. 

 

In Week 12 

The results of the Chemistry Digital Photo Archive project will have been collated and the 

results plus the "gallery" of images will be publicised in various ways. Thanks for your 

involvement in the project. We hope you have enjoyed it - and learned some more chemistry 

in the process. 

 

Assessment 

Successful completion of ILT 4 is a hurdle requirement for Chemistry 101. Successful 

completion includes: 

 

1. Uploading at least two photos with appropriate titles, tags and descriptions 

2. Completing the LMS MU_Chem survey for review/nomination 
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Biology Photo Sharing Project: Instructions for Stu dents 
 

Charles Sturt University BIO203 

 

Uploading images and descriptions to Beetle Gallery 
 
Getting to the Beetle Gallery 
 
The Beetle Gallery has been created using the Resources Tool in Interact. Instructions 
for accessing the Interact site for BIO203 are elsewhere in this subject outline. Once 
you have logged on to Interact and connected to the BIO203 site you can access the 
Resources tool through the link labeled “Resources” in the left-hand toolbar.  
 
Once you open the Resources Tool you will see that there is a Resource folder labeled 
“Beetle Gallery”. If you open the “Beetle Gallery” folder by clicking on the “+” sign, 
you’ll see that there are nine folders named “1. Beetles Collected From Vegetation 
Foliage” to “9. Beetles Collected From Carrion”.  
 
Creating a folder for your beetles 
 
You need to create a folder for each beetle in your collection. The folder should be 
created inside one of the nine folders within the gallery, depending on where you 
collected your beetle (eg. Vegetation Foliage, Flowers, Rocks etc.).  
 
Your folder should be named according to the following naming convention: 
YourSurname_AntennaType_LegType_ThoraxType_Beetle Number 
 
For example, you might call your folder: 
Wilson_Captitate_Cursorial_Straight_1 
 
Note that sample beetle folders beginning with the surname “Wilson” have been 
created in order to illustrate the files that need to be uploaded and the information that 
needs to be included. 
 
 
Placing your document and photos in the folder 
 
You will place in the folder at least three files: a document containing descriptive 
information about your beetle (as described above) and two photographs of your 
beetle. You may also place video footage of your beetle or an audio track of your 
beetle’s sounds in the folder if you wish. You should name your files as follows: 
 
About.doc Information about this beetle 
Photo1.jpg First photo 
Photo2.jpg Second photo 
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Video.xxx Video file (the xxx will depend on the file format as discussed below) 
Audio.xxx Audio file (again the xxx will vary depending on the file format)  
 
You can place your document, photos and other files in your beetle folder by selecting 
the “Add” option and then the “Upload Files” option next to your folder name in the 
Resources Tool. 
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Charles Sturt University BIO203 

 

Uploading images and descriptions to Beetle Gallery (continued) 
 
File formats 
 
The following are the preferred file formats for the various files you will upload. If 
you are unsure how to convert your files to these formats please upload them in 
whatever format you can: 
 
Information about the beetle:  Microsoft Word document (.doc) 
Photographs:    JPEG format (.jpg) 
Video footage    Windows Media Player (.wmv or .asf),  

QuickTime (.mov or .qt), or 
     MPEG (.mpg or .mp4) 
Audio tracks   MP3 (.mp3) or Windows Media Player (.wma) 
 
Additional help 
 
Links to tutorial materials on the use of the Interact Resources tool will be provided 
through the subject forum early in the session. Optional sessions in a computer 
laboratory will be scheduled at the Residential School to help students upload their 
beetle descriptions and photographs. A digital camera will also be available during 
these sessions for students who do not have access to one. 
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Medicine Podcasting Project: Technical Help for Stu dents 
 

Problm – problemcasting help 
 
 

Planning 

It is easier to record a ProblemCast if you work from notes or even a script. Plan what 
you want to say, the order in which you want to say it and have a practice run before 
doing the actual recording. The more preparation you do the less editing you will have 
to do later. 

ProblemCasts will be created in MP3 format so you can listen to them on any MP3 
player or computer regardless of the software installed on that system. 

ProblemCasts will be restricted to four minutes at medium quality (about 5 MB). 

The ProblemCasts you create will need to relate to a POW in some way and can be in 
one of three categories: 

·  Aha! I get it! ProblemCasts that offer an explanation of some aspect of the 
POW. 

·  Huh? I don't get it. ProblemCasts that express a difficulty about the POW.  
·  IMHO.  In My Humble Opinion. ProblemCasts that offer a comment on 

something related to the POW or course in general. 

Others students will be able to comment on and rate ProblemCasts and all 
ProblemCasts will be available for an entire semester. 

 

Recording 

You will need some recording software to make your podcasts. You can make recordings at 
home, on your portable recording device or in Tutorial room W724 on Level 7 of the Medical 
Building. We have allocated Mondays 2.15 - 3.15 pm each week during which you can come 
and make a recording and have some access to support.  

What you'll need 

If you want to work on your own machine then you will need to download some software and 
you will also need a microphone. Connect your microphone to the computer by the 
microphone jack or USB connector. We recommend the free audio recording software called 
Audacity. It works on Windows, Macintosh and Linux based computers. You will also need 
to download a converter to be able to save files in MP3 format. This is important if your 
recording device uses a different format such as WAV, WMA, AAC etc. If you have 
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downloaded and installed the software and you are familiar with how to use the program skip 
to the section "Making the recording". 

Downloading and installing 

To install software you will need administrator rights to your computer.  

1. Download the files you will need for your operating system 
a. Download the latest stable version (i.e. the non-beta version) of 

Audacity for your operating system from the Audacity website 
2. Download the MP3 plug-ins needed by Audacity for your operating system 

a. Download the LAME MP3 encoder (to convert files to MP3 format) 
from 
Windows users. 
http://audacity.sourceforge.net/help/faq?s=install&item=lame-mp3  
Mac users. 
http://audacity.sourceforge.net/help/faq?s=install&item=lame-mp3 
Note there are different versions depending on the type of Macintosh 
you have. 

3. Install both sets of files on your computer 

a. For Audacity, double click the installer to run it and follow the 
instructions during installation 

b. For the LAME mp3 encoder, uncompress (unzip) the encoder file if 
necessary and once this is complete put the entire encoder folder into 
the installed Audacity folder on your computer. More detailed 
instructions are available from the Audacity website 
(http://audacityteam.org/wiki/index.php?title=Lame_Installation) 

4. Start using Audacity and set up the preferences so that you can produce a 
medium quality audio file  

a. Click on menu "Edit > Preferences" on Windows (or "Audacity > 
Preferences" on the Mac OS). 

b. Click on the tab "Audio I/O", and set the playback and recording 
device to your headphone/speaker and microphone respectively. Set 
the channels to 1 (Mono). The Mono channel allows the production of 
smaller files. 

c. Click on the tab "Quality", set default sample rate to 44100Hz and 
default sample format to 16-bit. 

d. Click on the tab "File Format" to set up the MP3 export facility. Click 
on the "Find Library" button. Audacity will open a dialog asking you 
to locate the MP3 encoder.  
Windows users. Navigate to the Audacity Application and the Lame 
folder you put there. Open the Lame folder and select the lame_enc.dll  
Click "Yes"  
Mac users. Navigate to the Audacity application and the Lame folder 
that you put there. Open the Lame folder and select the LameLib file.  
In the same tab (File Format) set the bit rate for the MP3 encoder to 48. 

e. Windows and Mac users. Save the preferences by clicking "OK". 
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Becoming familiar with the Audacity program 

Click on the menu "Help > Contents…" 
This will open a new window that shows you what the buttons and other interface elements 
look like and the explains the functions of each element. Once you are familiar with the 
interface go to the section on "Making the recording" 

Making the Recording 

Recording an audio file using Audacity  

1. Click on menu item "Project > New Audio Track" to create a new empty track 
for recording. 

2. Set the volume slider (output volume) and the microphone slider (recording 
volume) to maximum on the mixer toolbar. 

3. Set the input source to "Microphone" by using the drop down menu beside the 
microphone slider. 

4. Click on the record button (red dot) to start recording. You can see the 
waveform being recorded on the track. Make sure that the waveform fits 
between the top and bottom of the track (+1.0 to -1.0). Anything above or 
below will be clipped and will sound distorted. If the waveform is too large, 
you may need to change the distance from your mouth to the microphone or 
alter the recording volume on the mixer toolbar. You can also view the 
recording levels on the upper right on the meter toolbar.  

5. Click on the stop button (yellow square) to stop recording. 
6. Click on the skip-to-start button (purple double backward triangles) to go to 

the beginning of the track. 
7. Click on the play button (green forward triangle) to replay the track. Listen to 

the track using headphones as that is how most of your listeners will hear it. 
Check that there is no problem in the recorded track. You may edit the track 
by adding introductory music (be mindful of copyright) or removing blank 
audio if necessary (see "Editing the recording").  

8. It's often very useful to Normalize your track before mixing. This removes 
excessive highs and lows. To do this Select the whole track by highlighting it 
(or use shortcut key Ctrl-A). Click on "Effect > Normalize" and make sure that 
both checkboxes are selected. Click the "OK" button. 

9. Save your work. Click on "File > Export as MP3". Choose a location and save 
the file. A dialog window appears with fields for title, author, album, track 
number, year, genre and comment. Fill out these fields. For the genre category, 
select speech (repeatedly tap the "S" key on the keyboard until the "Speech" 
category appears) and in the comment category type the POW eg 302 to which 
the recording refers.  

Editing the Recording 

You will probably notice that your podcasts aren't perfect and so you may wish to or you may 
need to edit the track you have created. This can also be done before you save your track. 
Sometimes, however, you might need to re-record your track. You can go for a polished 
recording or something less formal with a more spontaneous sound. Editing can take a lot of 
time so think carefully about the type of recording you want to post. 
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One thing you will need to check is the size of your recording as that is how we will limit the 
upload. We will not accept anything bigger than 5 MB, which is about 4 minutes of medium 
quality audio. 

There are a range of edits that you wish to make. You may want to create more than one track 
and blend them by fading in and fading out. Most commonly you will probably want to 
remove unwanted sounds or areas of silence. These can be selected and deleted or they can be 
filtered by Noise removal (Effect > Noise removal…) or equalization if the noise is outside 
the human voice range (Effect > Equalization…). You can also add silence (Generate > 
Silence…). All of the effects are detailed in the help.  

Important note for Mac users  

Mac users. Please note there is an issue with the LAME mp3 encoder plugin. You will need 
to resave your file with iTunes to be able to upload it to the website. Instructions are available 
at Alternative MP3 encoding with iTunes or follow these steps 

Set-up iTunes 

1. Open iTunes 
2. In iTunes select Preferences 
3. Select the "Advanced" tab 
4. Select the "Importing" tab 
5. In the "Import Using" dropdown, choose "MP3 Encoder" 

Convert the file 

·  Now drag your Audacity file to the iTunes library. Select it and Control-click 
to convert this file to mp3.  

·  This file will automatically be saved with other files in the iTunes music 
folder. Select the new file and either Control-click > Show Song file or 
Command-R to open a window containing the file. Drag the file to a 
convenient location or navigate to that folder to upload the file to the website. 

 

Posting 

Once you have finished your recording you will need to post it or upload it to the 
Problm website. 

To upload your ProblemCast you will need to: 

·  Go to the URL http://www.mdhsonline.unimelb.edu.au/problm/  
·  Login. 
·  Select the POW to which you want to add your ProblemCast. 
·  Click on the button "upload new track". 
·  Browse for your file on your computer. 
·  Fill out the rest of the form (all fields are compulsory).  
·  Check the box to indicate you have read and understood the conditions under 

which ProblemCasts are made available. No ProblemCast will be posted 
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without this agreement. We reserve the right to remove any ProblemCast that 
we consider is outside the spirit of these conditions.  

·  Click "Submit" and your ProblemCast will be posted.  

You will receive feedback about whether your file has been uploaded successfully or 
not. Important! Mac users please read on. 

Mac users. Please note there is an issue with the LAME mp3 encoder plugin. If you 
get an error stating that the file must be in MP3 format, you will need to resave your 
file with iTunes to be able to upload it to the website. Instructions are available at 
Alternative MP3 encoding with iTunes or follow these steps 

Set-up iTunes 

1. Open iTunes 
2. In iTunes select Preferences 
3. Select the "Advanced" tab 
4. Select the "Importing" tab 
5. In the "Import Using" dropdown, choose "MP3 Encoder" 

Convert the file 

·  Now drag your Audacity file to the iTunes library. Select it and Control-click 
to convert this file to mp3.  

·  This file will automatically be saved with other files in the iTunes music 
folder. Select the new file and either Control-click > Show Song file or 
Command-R to open a window containing the file. Drag the file to a 
convenient location or navigate to that folder to upload the file to the website. 

Accessing 

Once you have logged in, you will see the ProblemCasts that are available for your 
semester, which are organised by Problem of the Week. 

To access ProblemCasts: 

·  Click on a particular week to access all the ProblemCasts that have been 
submitted for that problem. 

·  Select the ProblemCast you want to listen to. 
·  Listen to the ProblemCast (track) using the controls or save it to your 

computer by simply clicking on the button "Save this track". 
·  You can give tracks a 'star' rating using the drop down menu (you can only do 

this once). 
·  You can comment on tracks using the text box. 
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Subscribing 

There are a number of ways to subscribe to a ProblemCast and a lot depends on the software 
that you use. This description is written for iTunes because it is very popular. If you use 
another 'podcatcher', let us know and we can write a description of how to use it with Problm. 

Subscribing using iTunes 

·  Go to the Problm home page ( 
http://www.mdhsonline.unimelb.edu.au/problm/ ). 

·  Put the cursor over the button "Subscribe to RSS feeds" and right click 
(Windows) or Control click (Macintosh).  

·  Depending on your browser, select the option that copies the link eg "Copy 
shortcut" (Internet Explorer), "Copy link location" (Firefox), etc 

·  Open iTunes. 
·  From the Advanced Menu, select "Subscribe to podcast...". 
·  Paste the link location in the pop-up box and click "OK". 
·  You can now download and listen to the podcasts as they are added. 
·  If you want newly generated ProblemCasts to automatically download to your 

iTunes go to 'Preferences' in iTunes. From here select the 'Podcast' tab and 
check for new episodes 'every day' and when new episodes are available 
'download all'. 

RSS 

You may want to be notified of new tracks by RSS and this can be done by subscribing to the 
feed using an aggregator or feed catcher . There are many feed catchers on the market see 
http://en.wikipedia.org/wiki/List_of_feed_aggregators. Some are linked to web browsers, or 
email clients, but most are independent pieces of software. Because there are so many 
aggregators around, please check your aggregator's help for how to subscribe to an RSS feed.  
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Arts Social Bookmarking Project: Workshop for Stude nts  
 

Social bookmarking - collaborate online to store and 
rate research sources  
 
A social bookmarking tool allows you to compile a list of Internet resources that you 
are interested in, on a free public web site. You can assign your own keywords / tags 
and annotations (such as comments, reviews, etc.) to each resource. You can share 
your list of links with a select group, or with all web users.  
 
A social bookmarking web site can: 

·  rank resources and display them in “tag clouds”;  
·  provide RSS feeds to keep users updated;  
·  support formation of special interest groups;  
·  integrate with other kinds of web sites such as blogs.  

 
There are many popular social bookmarking tools and sites on the web -  
http://del.icio.us is probably the best known. Others such as http://www.citeulike.org 
and http://www.connotea.org are more suited to academic use, and may integrate with 
personal citation management tools like EndNote. 
 
In 2008, students and staff at The University of Melbourne are using the social 
bookmarking tool http://www.diigo.com/ to support essay-writing in First Year Arts 
Foundation Subjects. Introductory workshops running in April 2008 can be found 
under “Library Tours and Classes” on the ArtsSmart left-hand menu.   
 

����
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Arts Foundation Subjects – Social Bookmarking 
Workshops 

·  Description: A one hour introduction to social bookmarking. Social 
bookmarking is an online activity that lets you collect, annotate and share 
useful websites for study and research.  Social bookmarking can help you to 
access and evaluate a wide range of information sources in preparation for 
essay writing. Using the social bookmarking tool Diigo for this purpose is an 
officially recognised way to meet your requirement for online engagement 
within the First Year Arts community.  This hands-on class will explain the 
general idea of social bookmarking, get you started using Diigo, work through 
some examples of how to critically evaluate websites for essay writing in your 
subjects, and allow time for you to make progress on your online community 
contribution.  This class is available only to students undertaking Arts 
Foundation Subjects.  

·  Subject: 100-185; 100-184; 100-187; 100-188  
·  Faculty - subject: Arts  
·  Class size: 20  
·  Duration:  60 minutes  
·  Target Audience: Undergraduates  
·  More information:  Mary Coghlan  

 
 

Arts Foundation Subjects – Social Bookmarking / 
Library Skills Drop-in Sessions 

·  Description: Staff will be on hand during this hour to provide one-to-one 
assistance to students who are using the social bookmarking tool Diigo to meet 
the requirement for online engagement within the First Year Arts community.  
Staff will also be available to give students individualised help to follow up 
any aspect of the library’s literature searching and information skills 
workshops. These sessions operate on a first-come first-served basis – no need 
to book. They are available only to students undertaking Arts Foundation 
Subjects.  

·  Subject: 100-185; 100-184; 100-187; 100-188  
·  Faculty - subject: Arts  
·  Class size: N/A  
·  Duration:  10-15 minutes per student 
·  Target Audience: Undergraduates  
·  More information:  Mary Coghlan  
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Arts Social Bookmarking Project: DIY Guide for Stud ents  
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“ In a social bookmarking system, users save links to web pages that they want to rem ember and/or 
share . These bookmarks are usually public, and can be saved privately, shared only with specified people 
or groups, shared only inside certain networks, or another combination of public and private domains. The 
allowed people can usually view these bookmarks  chronologically, by category or tags, or via a search 
engine. 
Most social bookmark services encourage users to organize their bookmarks with informal tags  instead 
of the traditional browser-based system of folders, although some services feature categories/folders or a 
combination of folders and tags. They also enable viewing bookmarks associated with a chosen tag, 
and include information about the number of users who have bookmarked them.  […] 
As these services have matured and grown more popular, they have added extra features such as ratings 
and comments on bookmarks, the ability to import an d export bookmarks from browsers, emailing 
of bookmarks, web annotation, and groups  or other social network features.” 
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